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Notations Used in This Guide

The following table shows the symbols used in this manual, along with descriptions of what they mean.

Attention Indicates procedures which may result in damage or injury if sufficient care is not taken.
=~ ~- Indicates additional information and points which may be useful to know regarding a topic.
/@\
- Indicates a page where detailed information regarding a topic can be found.

Procedure Indicates operating methods and the order of operations.

The procedure indicated should be carried out in the order of the numbered steps.

[ (Name) ] Indicates the name of the buttons on the projector's remote control or the control panel.

Example: [Esc] button

"(Name)" Indicates the name of the buttons on the EasyMP Monitor or OS screens.
Timer (Boldface) Example:

Select "Timer" - "Timer Settings".
Select Timer - Timer Settings.
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EasyMP Monitor Features



Tasks that can be done using EasyMP Monitor

EasyMP Monitor lets you carry out operations such as checking the statuses
of multiple EPSON projectors that are connected to a network at a
computer monitor, and controlling the projectors from the computer.

Following are brief descriptions of the monitoring and control functions
that can be carried out using EasyMP Monitor.

¢ Registering projectors for monitoring and control
Projectors on the network can be searched for automatically, and you can
then select projectors to be registered from the projectors that are
detected.
You can enter the IP addresses for target projectors to register them.

¢ Registered projectors can also be assigned to groups so that they can
be monitored and controlled in groups.

e Monitoring the statuses of registered projectors
The power status (ON/OFF) for projectors and problems or warnings
requiring attention can be checked visually by means of icons.
You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or the
details of information such as input sources, problems, and warnings for
these projectors.

¢ Controlling registered projectors
Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.
Web control functions can be used to change the settings in the
projector's configuration menu.
If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use Timer Settings to
register timer settings.

e Mail notification function settings
You can set e-mail addresses to which notifications are sent if a status
requiring attention, such as a problem, occurs with a projector that has
been registered.

¢ Sending messages to registered projectors

You can send JPEG files to the registered projectors at once by using
Message Broadcasting, which is a plug-in software for EasyMP Monitor.
The software and manual can be downloaded from the website below.
http://www.epson.com/
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Installing EasyMP Monitor

e Operations carried out at the computer may become slow depending on
the number of projectors being managed. If this happens, use a
computer with higher specifications.

e EasyMP Monitor cannot be used in environments which do not allow
pings to be transmitted.

Operating environment

This software is compatible with computers that comply with the following
requirements.

oS Windows 2000 Professional SP4
Windows XP Home Edition SP2/SP3*
Windows XP Professional SP2/SP3*

Windows Vista”
(All editions except Starter Edition)

Transferring the settings

If you are already using EasyMP or EMP Monitor, you can transfer the

Windows Vista SP1/SP2" projector settings to this version. The settings are stored as a data file (EMP
(All editions except Starter Edition) Monitor.dat). Make a copy of the EMP Monitor.dat before you install this
Windows 7 32 bit version software. EMP Monitor.dat can be found at the following location if the
(All editions except Starter Edition) default settings were used to install the software:

Windows 7 64 bit version
Windows 8 32 bit version
Windows 8 64 bit version
Windows 8.1 32 bit version

e If your operating system is Windows 2000 or Windows XP
"C:\Program Files\EPSON Projector\EasyMP (or EMP) Monitor Ver.
XXX (Ver. X.XX represents the software version)"

Windows 8.1 64 bit version o If your operating system is Windows Vista, Windows 7, or Windows
Windows 10 32 bit version 10
Windows 10 64 bit version "C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON

Projector\EasyMP (or EMP) Monitor Ver. X.XX (Ver. X.XX represents
the software version)"

If you cannot find the "AppData” folder, click "Start" - "Control Panel" -
"Appearance and Personalization" - "Folder Options". Select the "View"

e Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz
or higher recommended)

Memory capacity | 64 MB or more (128 MB or more recommended) tab, and then configure the "Show hidden files, folders, and drives" setting

Free hard disk 50 MB or more in "Advanced settings".

space

Display SVGA (800 x 600) or higher resolution, 32 bit or higher :"’—_ If your operating system is Windows 10, right-click "Start", and then
display colour ’@‘ click "Control Panel".

*  Supports only 32 bit version of OS.

e Macintosh computers cannot be used.
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o If your operating system is Windows 8 or Windows 8.1
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector\EasyMP (or EMP) Monitor Ver. X.XX (Ver. X.XX represents
the software version)"

If you cannot find the "AppData" folder, select "Charms" - "Search"-
"Control Panel" - "Appearance and Personalization" - "Folder Options".
Select the "View" tab, and then configure the "Show hidden files, folders,
and drives" setting in "Advanced settings".

After installing this software, follow the instructions below before starting
EasyMP Monitor to transfer the settings.

e If your operating system is Windows 2000 or Windows XP
Overwrite the existing EMP Monitor.dat file with the copy you made. The
existing EMP Monitor.dat file is in "C:\Program Files\EPSON Projector
\EasyMP Monitor Ver.X.XX".

o If your operating system is Windows Vista, Windows 7, Windows 8,
Windows 8.1, or Windows 10
Place the copy of the EMP Monitor.dat file in "C:\Users\(User Name)
\AppData\Local\VirtualStore\Program Files\EPSON Projector\EasyMP
Monitor Ver.X.XX".

Double-click the downloaded software file to start the install program.
Follow the on-screen instruction.

If EasyMP or EMP Monitor is already installed, uninstall it before installing
this software. @ "Uninstalling EasyMP Monitor" p.43

When using Windows Vista: You must update to Windows Vista SP1 to
use the Ukrainian version.

’@_ The software name has been changed.
‘ Before: EMP Monitor — After: EasyMP Monitor

If you are already using EMP Monitor, you can replace with this
software.

Limitations imposed by a Windows Vista, Windows
7, Windows 8, Windows 8.1, or Windows 10
environment

When using EasyMP Monitor under Windows Vista, Windows 7, Windows
8, Windows 8.1, or Windows 10, note the following limitations.

e You must have administrator authority in order to use Register at
startup on the Environment setup screen of EasyMP Monitor.
@ "Monitoring using the system tray" p.26

e If EasyMP Monitor is installed on your computer, uninstall it before
you update the operating system to Windows Vista, Windows 7,
Windows 8, Windows 8.1, or Windows 10. Updating your OS without
uninstalling the software may cause a malfunction. @ "Uninstalling
EasyMP Monitor" p.43

Installing

You must have administrator authority in order to install EasyMP Monitor.
Download the latest version of EasyMP Monitor from the website below.

http://www.epson.com/

Before starting operations

Check the following points before starting up EasyMP Monitor.

e EasyMP Monitor must be installed on the computer to be used for
monitoring and control.
e The computer and the projectors must be connected to the network.


http://www.epson.com/

Installing EasyMP Monitor

e Depending on the projector model, a commercially-available serial «»
TCP/IP conversion adapter and a connection cable are required in order
to use EasyMP Monitor. @ Projector's User's Guide "Standby Mode"
Make the settings for the serial «» TCP/IP conversion adapter before
connecting to the projector.

== To enable projectors to be monitored and controlled even when they
@ are in standby mode*, make the following settings at the projectors.
The settings that need to be made will vary depending on the
projector you are using. @ Projector's User's Guide

e Set Standby Mode to Communication On (or Network On).

e Set Network Monitoring to On.

* When the projector's (}) indicator is lit orange.
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Registering and deleting projectors for monitoring

This operation is carried out when starting EasyMP Monitor for the first
time after it has been installed and when you would like to add projectors.
Once a projector has been registered, the status for the projector will be

displayed automatically each time EasyMP Monitor is started from that

point onwards.

Starting EasyMP Monitor

) Use one of the following methods to start EasyMP Monitor.

The operations to register projectors vary as followings depending on where e If your operating system is Windows 2000, Windows XP, Windows
the projectors are connected to in the network. Vista, or Windows 7

Click "Start" - "Programs"” (or "All Programs") - "EPSON Projector” -
"EasyMP Monitor Ver.X.XX" in that order to start EasyMP

You can register up to 1,024 projectors or groups.

e When registering a projector that is located in the same segment as the
computer in which EasyMP Monitor is installed. @ "Registering

projectors using automatic search (Searching for and registering Monitor.
projectors that are located in the same segment)" p.12 e If your operating system is Windows 8, or Windows 8.1

» When registering projectors that are in multiple segments of the Select "Charms" - "Search" - "EasyMP Monitor Ver.X.XX" in that
network. @ "Setting the range of addresses to do an automatic search order to start EasyMP Monitor.

d istration" p.14
anc registiation p o If your operating system is Windows 10

Select "Start" - "All apps" - "EPSON Projector" - "EasyMP Monitor
Ver.X.XX", and then start "EasyMP Monitor".

The main window will be displayed.

The red box area described in the screen below is referred to as
Grouping view.
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[ Specify an address range and search,

Start address End address

Search Edit Cancel

Click "Search".
Registering projectors using automatic search Automatic searching will be carried out, and the names of the
(Searching for and registering projectors that are projectors that have been detected will be displayed.
located in the same segment)

If a projector does not appear in the list, use "Registration by
specifying an IP address (Manual registration)". @ p.16

Create new projectar {automatic registration)

Procedures for automatic search

Projector name IP address
Projector10 192168.040
Projector1d 192168041
Procedure Projectar12 192168042
s Projector]3 192168043
éf R. h I. k . G . . d I “N " "P . Projector1d 192168.0.44
\—/ Right-click in Grouping view and select "New" - "Projector Projectorl5 192168045
(automatic search)". Prajectarl6 102168046
The following Create new projector (automatic registration) window
will be displayed.
If Detail list view is displayed, select New - Projector (automatic

Search) from the Edlt menu [ Specify an address range and search,
Start address End address

Search Edit Cancel
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~r ~- ® You can also carry out this operation by selecting New - Projector
'@‘ (automatic search) from the Edit menu. Display name [l
e Projectors that are using a serial «» TCP/IP conversion adapter e
Dizplay inon
cannot be detected. @ @
< | |
Procedures for registration
Parent group ] [Maone) LJ
Procedure Projector name ]Projector‘ID
. IP address | 169 . 254 . 163 . 151 Seach
% W Select the projector(s) to be registered from the displayed list, i mitite
and then click "Edit".
Port Mumber
The following window will be displayed.
Manitor Password ]
Deseiplion
Vﬁp‘n‘t‘ér
Begister . I Cancel

Make the necessary settings while referring to the following table.

Display name Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.

Display icon Select the icon(s) to be displayed in Grouping view or
Detail list view.
Parent group Select when registering a projector in a group.

If no groups have been created, this cannot be selected.

@ "Registering several projectors to a monitoring
group all at once" p.18
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Projector name | This shows the name that has been registered on the To end the registration operation, click E in the top-right

jector. . .

projector corner of the window or click "Cancel".
IP address This shows the IP address for the registered projector. The icon(s) of the projector(s) you registered will be displayed in
Use Serial « This cannot be selected when registering projectors Grouping view or Detail list view.

- i i h. " o . " . .
I;I:‘/;::m::fr using automatic searc Refer to @ "Monitoring window layout" p.21 for details on using
pror. the Grouping view and Detail list view.

Port Number This cannot be selected when registering projectors

using automatic search.
Monitor Pass- If a Monitor Password has been set for the projector, be . .
word sure to enter the Monitor Password that has been set. If Settlng the range of addresses to do an automatic

the correct password is not entered at this time, it will not search and reg istration

be possible to monitor and control the projector even

though it is registered.

-~~~ Projectors that are using a serial «» TCP/IP conversion adapter cannot

Description You can enter some kind of memo about the projector. j@s be detected.

The details you enter here will be displayed at the

projector properties.

Up to a maximum of 60 bytes can be entered.

Procedures for automatic search

Monitor Select this when you want monitoring to start.

After entering the details, click "Register" to start the

registration. When the message is displayed, click "OK".

) Right-click in Grouping view and select "New" - "Projector

To continue registering other projector(s), repeat steps 1 and 2.
8 8 pro) P P (automatic search)".

:@: Projectors that have been registered using automatic search are
4

‘ searched for again by projector name each time EasyMP Monitor is
started. If Detail list view is displayed, select New - Projector (automatic
search) from the Edit menu.

The Create new projector (automatic registration) window will be
displayed.

Select the "Specify an address range and search." check box
and then enter "Start address" and "End address" in the range.
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Iv Bpecify an address range and search,

Start address

. 50 )

=~

Search

( 192 . 168 . 0 . OO )ndaddress ( 192 . 168 . 0O

Edit Cancel

Click "Search".

Automatic searching will be carried out, and the names of the
projectors that have been detected will be displayed.

Create new projectar (automatic registration)

Frojector name
Projector1l
Projector1i
Projector12
Projector13
Projector14
Projector1h

Projector1f

|v Spedfy an address range and search.

Start address 192 . 168 . 0O

Search

IF address

192168040
192168041
192168042
192168043
192168044
192168045
192168046

. oo End address 192 . 168 . 0

Edit Canicel

Procedures for registration

Procedure

Select the projector(s) to be registered from the displayed list,

and then click "Edit".

The following window will be displayed.

Dizplay name

Dizplay jcon

Parent group
Projector hame
IP address

ml

Part Mumber
Maonitor Password

Description

v | Hq’iitﬁn-

1| | ]
|[Nane) |
|Projector10
| 169 . 254 . 163 . 1A Search

—

Register Cancel

Make the necessary settings while referring to the following table.

Display name

Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.
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Display icon

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Parent group

Select when registering a projector in a group.

If no groups have been created, this cannot be selected.
@ "Registering several projectors to a monitoring
group all at once" p.18

Projector name

This shows the name that has been registered on the
projector.

IP address

This shows the IP address for the registered projector.

To end the registration operation, click E in the top-right
corner of the window or click "Cancel".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view or Detail list view.

Refer to @ "Monitoring window layout" p.21 for details on using
the Grouping view and Detail list view.

Use Serial «—
TCP/IP conver-
sion adaptor.

This cannot be selected when registering projectors
using automatic search.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

registration. When the message is displayed, click "OK".

To continue registering other projector(s), repeat steps 1 and 2.

Registration by specifying an IP address (Manual
registration)

" Right-click in Grouping view and select "New" -
(manual registration)".

"Projector

>

The following window will be displayed.

If Detail list view is displayed, select New - Projector (manual
registration) from the Edit menu.
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Display name [l
Display ican
B e o
< J i
Parent group |Nane] -l
Prajector name |
IP address | . . i Search

[~ Use Serial <= TCPAP conversion adaptar.

Part Murnber
Manitar Pazsword |
Description
v | Monitar
HRegister Cancel

After searching is complete, enter the information for the

projector to be registered while referring to the table below.

Display name

Enter the name of the projector(s) to be displayed in
Grouping view or Detail list view. Up to a maximum of 32
bytes can be entered. A space cannot be used as the first
character.

Display icon

Select the icon(s) to be displayed in Grouping view or
Detail list view.

Parent group

Select when registering a projector in a group. If no
groups have been created, this cannot be selected.

@ "Registering several projectors to a monitoring group
all at once" p.18

Projector name

This shows the name that has been registered on the
projector.

IP address

This shows the IP address that you entered in step 2.

Use Serial «
TCP/IP conver-
sion adaptor.

Select this if using a serial «» TCP/IP conversion adapter
to connect the projector.

Port Number

If using a serial «» TCP/IP conversion adapter to connect
the projector, enter the port number.

\ls
~ =

— -
N
,I

You can also carry out this operation by selecting New - Projector
(manual registration) from the Edit menu.

Enter the IP address of the projector to be registered in the "IP

address" box and then click "Search”. When the message is
displayed, click "OK".

If using a serial «» TCP/IP conversion adapter and cable to connect
the projector, select Use Serial «» TCP/IP conversion adaptor, enter
the port number in Port Number, and then click Search.

Monitor Pass-
word

If a Monitor Password has been set for the projector, be
sure to enter the Monitor Password that has been set. If
the correct password is not entered at this time, it will not
be possible to monitor and control the projector even
though it is registered. If using a serial «» TCP/IP
conversion adapter to connect the projector, the Monitor
Password security function cannot be used.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.
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s—,
@ After entering the details, click "Register" to start the
registration. When the message is displayed, click "OK".

Graup name | |

The icon(s) of the projector(s) you registered will be displayed in .

Grouping view or Detail list view.

Registering several projectors to a monitoring Mo =
group all at once

Regizter Cancel

Projectors that have been registered can then be registered together into

different groups so that they can be monitored and controlled together. Group name Enter the name of the group to be displayed in Grouping
view or Detail list view.

Furthermore, if you select one of the registered groups as the Parent group,
monitoring and control operations can be carried out for all projectors in
that Parent group.

Up to a maximum of 32 bytes can be entered. A space
cannot be used as the first character.

A Parent group can be set for other parent groups, so that a hierarchical Display icon Select the icon(s) to be displayed in Grouping view.

group arrangement can be created. Parent group This selects the parent group. If no groups have been
created, this cannot be selected.

First, create the registration groups, and then register projectors into the

groups that have been created Monitor Select this to monitor all projectors that have been

registered in the group. If this is not selected, the settings
made when the individual projectors were registered will

be used.

It cannot be set when creating a new group.

" Right-click in Grouping view and select "New" - "Group".

The following window will be displayed. :@—_ You can also carry out this operation by selecting New - Group from

Make the necessary settings while referring to the table below. the Edit menu.

If Detail list view is displayed, select New - Group from the Edit
menu.
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\ / When the setup is complete, click "Register" to start the
registration. When the message is displayed, click "OK".

The icon(s) of the projector(s) you registered will be displayed in
Grouping view.

/ Right-click the projector icon(s) to register to the group you
have created in Grouping view or Detail list view, and select
"Edit".

Az
~ -

=~ You can also carry out this operation by selecting Edit in the Edit
'@ menu.

In the Edit projector window, select the group name to use for
registering in Parent group and then click "Change".

The status of the group registration will be displayed as an icon in
Grouping view.

A\l
~ =

== The registration details can also be checked using Projector list in the
’@ View menu.

If the projector name or IP address changes after
registration

For projectors that have been registered manually

Procedure

Right-click on a projector icon in Grouping view or Detail list
view and select "Monitoring disabled". Then right-click the
projector icon again and select "Edit".

- You can also carry out these operations by using the Edit menu.

’ If only the projector name has been changed, click "Search" in
the Edit projector window that is displayed. If the IP address
has been changed, enter the new IP address in the "IP address"
box and then click "Search". When the message is displayed,
click "OK".

) When the display returns to the Edit projector window, click
"Change".

For projectors that have been registered using automatic search

Procedure

/ Delete the projector(s) whose name or IP address has been
changed in Grouping view or Detail list view. @ p.19

N ) Carry out automatic search to re-register the projector(s).
@ p.12

Cancelling projector registrations (Delete)

The registrations for projectors can be deleted if they are no longer required
for monitoring or control using EasyMP Monitor.
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Right-click the icon for the projector or group that is to be deleted in
Grouping view or Detail list view and select "Delete". When the
message is displayed, click "OK".

More than one projector can be selected for deleting by selecting in
Grouping view or Detail list view.

The methods of selecting more than one projector at the same time are as
follow.

e If you select a Group icon in Grouping view, all projectors that have
been registered in that group will be deleted at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.

<~ You can also carry out this operation by selecting Delete in the Edit

’@‘ menu.




Monitoring window layout

Types of monitoring windows and switching How to switch views

method Grouping view and Detail list view are switched as follows.

Types of monitoring windows

There are two types of monitoring windows. Select a desired window. Click the View menu, and select "Grouping view" or "Detail list

¢ Grouping view view".
This view lets you check the status of group registrations in a

hierarchical diagram.
=

"ol g o6 AR=amRsE=aEsmssanaE Monitoring using Grouping view
Meanings of Grouping view icons
K 2 @
In Grouping view, the patterns on the icons indicate the statuses of the
wwwwwww projectors. If the group icons are round in shape, it indicates that there is
B B @ | another level below them. @ p.22
Grouping view o8 Wb

Eile  Edt Yiew Tool Help
| Refish Select al OO BExfEEod=8FHA=mwEwm %I

e Detail list view =l

This view lets you display the status of each projector as a list so that
the projectors can be checked in detail. You can also display specific

items as a list, and sort display items using a specific row as a sort
key. Branch B Branch C
=
o 00 EE~HEBW-S8=E A AR :
hznlg I Pﬂwrv@ [ Larp o ;w Temparature evel | Evceirfomaton -] @
B lonwoie | e g o - of, Corvertion e
€8 SehAToibd  Posisi2 aw —— owroom obby
= @ - Hall
i i
@ = ) o —
& = o x —-—
@ o o
® o - %
g :‘ g ‘f: Showroom & Showroom B
@ o 0 o -
@ Feont <) ™
@ o o o ) a = -
o) 1 o
Detail list view @ & e

Mol No2 Mo3 -~




Monitoring window layout

The icon patterns and their meanings are explained below.

Group

No warnings or problems
All projectors in the group are normal.

Warning or problem
A projector in the group has a warning or problem status.

Notification
A projector requiring immediate attention has been detected within the
group.

Monitoring disabled

The projector is not being monitored. If you right-click the icon and select
Monitoring enabled, the projector will be added to the projectors that are
being monitored.

Data being updated

Projector

€

No warnings or problems”!

Warning or problem

Notification

Monitoring disabled

Data being updated

) ¢« @0 &

&)

Network error (Monitor Password authentication error)

No Monitor Password was entered when the projector was registered,
or an incorrect Monitor Password was entered. @ p.13, p.15, p.16

Projector

~ | Network error (TCP connection error)*2

~— | Network error (ESC/VP.net communication error)*3

*1 When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off. As
you can get an idea of how the temperature inside the projector is increasing
when Temperature level is displayed, you can make improvements to the
projector's operating environment before a high internal temperature error or
high-temperature warning occur. @ p.27

*2  Check the following items.

- Check that the projector's power is turned on.

- Check that the LAN cable is connected.

- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.

¥3  Check that the projector has been correctly connected to the network.

- The projector information that is generated when a problem is

@ detected is stored until EasyMP Monitor is closed. EasyMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click "Refresh" in the main window to update the
status.

Using the icons in Grouping view

The following icon operations can be carried out in Grouping view.
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e Expanding and collapsing icons Warning or problem
Each time you double-click a group icon, the icons for the projector An error has occurred on the projector.
that have been registered in that group are displayed or hidden.

=

Notification

(4

* Moving icons The projector requires immediate attention.
To change the position of an icon within Grouping view, simply drag .

Monitoring disabled
and drop the icon to be moved. 8

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

Monitoring using Detail list view Data being updated

4

)

Network error (Monitor Password authentication error)

. — . . v
Meanings of Detail list view icons No Monitor Password was entered when the projector was

registered, or an incorrect Monitor Password was entered. @ p.13,
p-15, p.16

Network error (TCP connection error)*2

The status of registered projectors is displayed as a list in Detail list view
regardless of which Group the projectors belong to.

6

Network error (ESC/VP.net communication error)*3
L O X
Eile| Edit View Toaol HE‘D 9 G
Fefiesh seatlt @ OO BE-FEEooBeHEsEEqq%EE roup name
W fopley name et arp Hors V[Ferpermus vl VEro: riomaiion . .
=y When projectors are registered to a group, the name of the group that the
] | Sv— it @ 1o0m prm— projector belongs to is displayed.
fi_a Branch 4/Convention Hal Tojectorl2 @ BOH | — -
@ Branch 4/Showmom. /Showviaom & o1 @ 15H | E— ‘@ 9 DlsPlay name
@ B h £/Showimom. /Showviaom & 2 @ H | - Shows the display name'
@ B h £/Showimom /Showviom & 3 @ 85H | E——
@ Branch £/Showraom, /Showroom B o4 @ 20H | e P()Wer
m Branch A/Showraom/ Showaom B 05 @ BEH | | ShOWS the pOWer on Status fOr the projector.
ey | Jeranch B/Conterence Room i} Q 51 | ———
Y | S o Ie) -~  —" @ Power on and normal status @ Power off and normal status
585 | JBranch B/Corference Foam 2 Q@ 5H C |
U0 | et S | L @ ™ — @ Power on and abnormal Power off and abnormal
() | JErench E/Reception Fioom oom 1 @ 7H CEmes 1 tat tat
g | feranch e/mecepion Raom oo 2 Q@ e = | status status
l ' 2 © Lamp Hours

Shows the lamp operating time for the projector. If the projector has 2
lamps, it shows the lamp operating time for both lamp 1 and lamp 2.

@ Type @ Temperature level

Displays the projector status. The following five icons display the differing internal temperature status of
ga No warnings or problems®! the projector.

The icon patterns and their meanings are explained below.
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= | Internal temperature mm | Internal temperature @] High internal temperature ‘ﬁ Low air flow error
normal normal error
=== ] High-temperature == | High-temperature Eﬁ Air filter air flow sensor error Internal Error
warning warning S =
(2 a
mmmmm Internal temperature .."3‘] Fan error Sensor_error

error
Supply System Error (Ballast) Supply System Error (Ballast
@ Error information
Shows a notification or warning/problem status using the following icons.

Clean Air Filter Notice a Replace Lamp™4

Supply System Error (Ballast Auto Iris Error
2)

Cinema filter error fad Shutter error
8] Replace Lamp (Lamp 1) @ Replace Lamp (Lamp 2)

mﬂ@]@ﬁ

Cooling system error (Peltier Cooling system error (pump)

a] Lamp error (Lamp 1) Lamp error (Lamp 2) element)
a Lamp failure at power on Lamp failure at power on mm Exhaust vent shutter Error @ Easy Interactive Function
— Error
(Lamp 1) (Lamp 2)
Iﬂ High-temperature warning Replace Air Filter 5 Obstacle Detection Error @ Phase Difference Plate Error
S : 71| Power Voltage Error B Lens Shift Error
= No Air Filter Low Air Flow Lﬂr 8 @
=21 Air Flow Sensor Err. ?ppply System Error (Ballast @ No Lens Error E‘I'_I-E Laser Error
Supply System Error (Ballast Cinema filter warning Other error

2)

*1 When Temperature level display group view is set to On at Environment setu
Shutter warning p play group p

in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off.
*2  Check the following items.
- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
- Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.
*3  Check that the projector has been correctly connected to the network.

¥4 You can display Replace Lamp at any time preset at Environment setup in the
Lamp failure at power on Tool menu.

Obstacle Detection warning

Projector Direction Warning Lamp Mismatch Warning

5 5 &

7

Incorrect Installation Laser Warning

Position/Direction Warning

Other warning Lamp Cover Open

Lamp Error Lamp Error (Lamp 1)

SO EEFFAFD 9 PEE 8§«

Lamp Error (Lamp 2)

.

Emep

Lamp failure at power on Lamp failure at power on
(Lamp 1) (Lamp 2)
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\Nls

~- * The projector information that is generated when a problem is

'@‘ detected is stored until EasyMP Monitor is closed. EasyMP Monitor
displays will not be updated automatically even if the projector
status returns to normal. Click "Refresh” in the main window to
update the status.

e Detectable error information differs with the projector you are
using.

Selecting display items

You can select only the required items to be displayed in Detail list
view.

Procedure

§ Select "Option" from the View menu.

The Option window will be displayed.

Cption

Dizplay iems

<l

<l

Group name

Prajectar hame

<1

Dizplay name

IF address

< 1

Powuer

<l

Lamp Hours

Saource

<

Temperature level

-

Dezcription

<l

Error information

]9 Cancel

/ When all of the details of the item cannot be displayed in
Detail list view, drag the boundary line on the right of the item
name so that the view is extended to the desired width.

Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as
projector name order or IP address order.

Procedure

Click the item name of the row you want to use as the sort key.
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When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

Searching for desired icons (Projector list)

The Projector list feature is useful for searching in lists when many groups
and projectors are registered and the icon you are looking for is not
displayed on screen.

Procedure

Select "Projector list" from the View menu.

)
(® 4, 1013

The following window will be displayed. The icon patterns are explained below.

@ No problem /i, Problem

Show projec

SR Eranch A
£ g Convention Hall

& o
= Showraom Procedure

= Showroorn &
Ay Mol
& Moz
& Mo3

¥ () Showroom B

+ (3 Branch B
(9 Branch

) Select "Environment setup" from the Tool menu.

The Environment setup window will be displayed.

Select "Resident in the task tray".

Environment setup

With Projector list, temperature level icons are not displayed regardless of LEeL el F a3 e
the setting of Temperature level display group view at Environment fenpestue e diloygoupven o Ce
Setup. Lamp schedule natification & 0f  On m [

Log output & Off © On

The Projector list lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, Grouping view and Detail
list view are scrolled so that the selected icon is displayed in the window.

™ Register at startup

I™ Change the application lock passward

0ld password [

Mew password |

Mew passward (gonfim) |

Monitoring using the system tray -

Cancel

The projector statuses are always displayed as icons in the system tray, even
when Grouping view or Detail list view is not always displayed, and the
statuses can be checked by the icon patterns.

Click "OK".
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~»<- e Right-click the icon in the system tray to open a pop-up menu to
@‘ select the Open the main screen or Exit.
o If Register at startup in the Environment setup is selected, EasyMP E _—
Monitor starts automatically when the computer's power is turned Refiesh Seetal ¢ O = © 8= e e Y
on. When using EasyMP Monitor under Windows Vista, Windows inqfoiscly namf} Posed  cmo Hours Seurce. | {Temperatue love} | Enorinfomation
7, Windows 8, Windows 8.1, or Windows 10, you must have
administrator authority in order to use this function.

Projectortt | | (@) 120H N | N |
(-]

No3 @ 85

Displaying projectors with problem or warning
statuses in a list q ] O

You can display a list of only the projectors which have a problem or The icon patterns and their meanings are explained below.
warning status.
@ Type

Shows the group or projector status.
Procedure

Select "Warning and Error Projector list" from the View menu.

No warnings or problems*!

£

Warning or problem

Ed

A h d th jector.
The following Warning and Error Projector list window will be displayed. i eTron fas occuited of The projecior
Notification

If you move the mouse pointer over the icon of the Error information, The projector requires immediate attention.
details of the error and the remedy will be displayed. If you double-click in
a line, the properties for that projector will be displayed. @ p.30

(9

Monitoring disabled

The projector is not being monitored. If you right-click the icon
and select Monitoring enabled, the projector will be added to the
projectors that are being monitored.

Data being updated

Network error (Monitor Password authentication error)

)

) 4

%
é(

No Monitor Password was entered when the projector was
registered, or an incorrect Monitor Password was entered. @ p.13,
p-15, p.16

Network error (TCP connection error)*2

&)

a Network error (ESC/VP.net communication error)*3
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@ Display name

Iil Whiteboard ﬂ%m Screen Mirroring

Shows the display name.
@ Power
Shows the power on status for the projector.
@ Power on and normal status @ Power off and normal status

@ Temperature level

The following five icons display the differing internal temperature status of
the projector.

@ Power on and abnormal Power off and abnormal = 1 Internal temperature mm | Internal temperature
status status normal normal
@ Lamp Hours === ] High-temperature mmmm | High-temperature

Shows the lamp operating time for the projector. warning warning

@ Source
Shows the input source that has been selected for the projector.

A g Computer or Computerl B “ggg Computer2
QoL Q0L=:

Internal temperature
error

@ Error information

Shows a warning/problem status using the following icons.

. BNC 5 S-Video Replace Lamp™6 8] Replace Lamp (Lamp 1)
ﬁ. Video (RCA) = Video (BNC) Replace Lamp (Lamp 2) ? Lamp error (Lamp 1)
— Lamp error (Lamp 2) E Lamp failure at power on
ﬁ SDI HDBaseT (Lamp 1)
Lamp failure at power on (4] High-temperature warning
DisplayPort DVI-D1 or HDMII, (lamp 2) = o
DVI-D, HDMTI*4 Replace Air Filter & No Air Filter

DVI-D2 or HDMI2*5 HDMI3 ) )
Low Air Flow == Air Flow Sensor Err.

Supply System Error (Ballast @ Supply System Error (Ballast
1) 2)

Cinema filter warning tad Shutter warning

EasyMP

Obstacle Detection warning (&4 Projector Direction Warning

USB or USBI1 i

I:I£| USB Display

Lamp Mismatch Warning Caq Incorrect Installation
1 position/Direction Warning

Laser Warning & Other warning

F 28 8 PHE 8 €9 @
}1(11
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Lamp Cover Open Lamp Error - Check that Standby Mode is set to Communication On (or Network On) or
Network Monitoring is set to On in the projector's configuration menu.
Lamp Error (Lamp 1) Lamp Error (Lamp 2) *¥3  Check that the projector has been correctly connected to the network.

*4 Tt describes DVI-D if the projector is equipped with both DVI-D and HDMI
input terminal.

*5 It describes HDMI if the projector is equipped with both DVI-D and HDMI

Lamp failure at power on E}] Lamp failure at power on
= (Lamp 1)

?Ii\mp fa;i)lure at power on lnl High internal temperature input terminal.
: am error
p. ] ) *¥6 You can display Replace Lamp at any time preset at Environment setup in the
ﬁ Low air flow error ==| Air filter air flow sensor error Tool
= ool menu.

Internal Error '{E.a Fan error
T = :"'—_ Detectable error information differs with the projector you are using.
l!:ﬂ Sensor error Supply System Error (Ballast) z@‘

Supply System Error (Ballast @ Supply System Error (Ballast

1) 4 2)

Auto Iris Error Cinema filter error Checking properties in detail

Shutter error @ CIOOHH% system error (Peltier You can check the properties of Group and projectors in detail.

elemen

Cooling system error (pump) ﬁ Exhaust vent shutter Error

Displaying Group properties

D ap oe &

Easy Interactive Function @1 Obstacle Detection Error
Error
Phase Difference Plate Error [fF.| Power Voltage Error
A &PV
i Lens Shift Error @ No Lens Error You can use either of the following methods to display the

properties.

@ L E Oth
aser Error er error

*1 When Temperature level display group view is set to On at Environment setup
in the Tool menu, an icon indicating the internal temperature of the projector
will be displayed on top of the projector icon. The default setting is Off.

*2  Check the following items.

- Check that the projector's power is turned on.
- Check that the LAN cable is connected.
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¢ Displaying the properties for all groups in Grouping view

Right-click in Grouping view and select Property. e
° . . ofe .
D'1splay%ng the. speqfled group pl'.opertles S —
Right-click an icon in Grouping view and then select Property. S et
Display name Lobby
- IP address 1012.0.224
F!efrash sl (b Eg .;'.::5 £ @ @ — ﬁ “%' ! % [!;'l E Lamp Havrs 33H
Type | Display name | Power | Lamp Hours Source | Temperature level | Erar information Temperature level =1
_@_ Shawiraom - e e e . -
escription
@ ConventionHe == e e e
@ Lobhy @ H m [ ——] ISena\Numbar XX I o
Wersion information F1 64001 93067154030
F2 40040 A0S0 @
F3 6141w B 100
Error information Mo gignal
| | 2
If you double-click in a line, the properties for that group or projector will

be displayed.

@) Shows the projector's serial number. If hyphens are displayed, confirm the serial
Displaying Projector properties number on the label of the projector.

@ Displays the projector firmware version.
Right-click on a projector icon in Grouping view or Detail list view and

select Property.

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as
what has been controlled by EasyMP Monitor, projector errors. You can
delete logs once you have checked them.

:"'—_ When Log output is set to On at Environment setup in the Tool
'@‘ menu, transmission logs are stored. The default setting is Off.
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Displaying Log ~@—_ e You may not be able to select Export just after starting EasyMP

Monitor. If this happens, wait for about five minutes, and then select

e

¢ Information on all of the projectors registered as monitored
projectors in EasyMP Monitor is output as a CSV file. You cannot
select a specific projector and output the information for that

The web browser will open and the communication logs up until that time projector.

will be displayed.

Select "Log" - "View" from the View menu.

\ Select the location where you want to save the file, and then
Deleting Log save.

e The CSV file contains the following items.

- Projector name

Select "Log" - "Delete" from the View menu. When the confirmation - Display name

message is displayed, click "OK". - IP address
- Lamp Hours (Lamp 1)

- Lamp Hours (Lamp 2)
- Description

All logs will be deleted and details of EasyMP Monitor control operations
and details of projector errors from that point onward will be recorded in a
new log.

Outputting lamp hours as a CSV file

For projectors registered in EasyMP Monitor, you can output the number
of hours the lamp has been used as a CSV file which allows you to check
and edit the data. You can output a CSV file while projecting without
having to stop projecting.

Procedure

\ @ Select "Export" from the File menu.
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Carrying out control using control buttons

Click the icon of a projector to be controlled in Grouping view or Detail
list view, and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more than
one projector in Grouping view or Detail list view and clicking a control
button. The methods of selecting more than one projector at the same time
are as follow.

e If you select a group icon in Grouping view, all projectors that have
been registered in that group and that are set to be monitored can be
controlled at the same time.

e Hold down the Ctrl key on the keyboard while clicking on the desired
icons.

e Use drag and drop to select a range of desired icons.
oE - 0OX

Fle Edt View Tool Hslp

Refiesh | Select al @(b %%m@agﬁﬁ%ga

@

Branch B Branch C

R O w

Carvantion Lobby

Shawroom Hal

A &

Showroom A Showioom &

B B o

Mol No2 Mol -

The following table shows the meanings of the control buttons.

& Power On Turns the projector power on.
(o) Power Off Turns the projector power off.
— Switch source Switches the input source to the Computerl port
oak) Computer1l or Computer port.
Switch source Switches the input source to the Computer2 port.
oD Computer 2

Switch source Switches the input source to the BNC port.
(-]

BNC

&)

Switch source
Video

Switches the input source to the S-Video port.

Switch source

Switches the input source to the Video port or

o) . .
Video (RCA) video2 port.
ol Switch source Switches the input source to the Videol port.
& Video (BNC)

Switch source Switches the input source to the SDI port.
@

SDI

Switch source Switches the input source to the HDBaseT port.
i
HDET HDBaseT

Switch source Switches the input source to the DisplayPort
= .

DisplayPort port.

Switch source Switches the input source to the DVI-D1 port or

DVI-D, HDMI 1

HDMI1 port.

If the projector is equipped with either DVI-D
port or HDMI port, use this button to switch the
input signal.

If the projector is equipped with both DVI-D
port and HDMI port, use this button to select
DVI-D as an input source.
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Switch source

Switches the input source to the DVI-D2 port or

Al/s

=7 HDMI2 ~- © Some connected projectors may not be equipped with all of the
: DVI-D, HDMI 2 p9rt, , . , '@‘ above ports or functions. If you click a button for a port or function
If the projector is equipped with both DVI-D that is not available, nothing will happen.
port and HDMI port, use this button to select
HDMI as an input source. e You can select objects to be controlled and use the control buttons
to carry out control operations even when the following are being
=g Switch source Switches the input source to the HDMI3 port. displayed.
DVI-D, HDMI 3 Group properties @ p.29
Switch source D- | Switches the input source to the D4 port. Projector properties @ p.30
Video i j i
! Warning and Error Projector list
Switch source Switches the input source to EasyMP or (Control operations can only be carried out for projectors with a
EasyMP EasyMP.net. warning status.) @ p.27
Switch source Switches the input source to USB Display.
= . .
o= USB Display
Switch source Switches the input source to the external Carrying out control using a web browser (Web
i UsB1* equipment connected via a USB (Type A) port or
USBI. control)
Switch source Switches the input source to the external You can use the computer's web browser to change the configuration menu
T UsB2* equipment connected via a USB2 port.

%

Switch source
LAN*

Switches the input source to the image projected
by the computer via a network.

=

Switch source
Whiteboard

Switches the input source to Whiteboard.

e

Switch source
Screen Mirroring

Switches the input source to Screen Mirroring.

*

If the button does not function, you can switch the input source using the

button.

settings for projectors.

Procedure

§ Right-click on the icon of a projector to be controlled in
Grouping view or Detail list view and select "Web control".

The web browser will open and the Web control window will
be displayed.

Web control lets you set the same details as the configuration menu for the
projector. @ Projector's User's Guide
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~@— You can select projectors and right-click on them to select Web
4

™" control even when the following are being displayed.
Group properties @ p.29 Ercectos Date
= [ erarch A A 04/2009 na
Warning and Error Projector list (Control operations can only be 78 o et SN ] Mon | TUE [ wep [ TR ] i | AT
carried out for projectors with a warning status.) @ p.27 Bl — L.l [ ¢ T8 1%
@ Nol 12 17| 4 |18 16 17 [
& Moz 19 20 21 22 23 24 25
@ Mo3 26 27 28 29 30
= (@, Showroom B
@ Not
@ Nos T imers
c H t t I H t H tt H 1 [ branchs Display name Date Time 24 hour) Operation
arrying out control using tumer settings i [if Eanchc i e e e
vas Showroom B 4f7iz002 15:45 Pawer ON
L. . . . . @ no3 4i7j2009 18:59 Fower ON
This is useful for carrying out certain control operations such as turning a 5, showsom & s s Power o
. ' . . = [ConventonHall S0 dees
projector's power on and off at specified times every day or every week.

. . . . . . [< \ >
Timer settings can be ca.rrled out either for a single projector only, or all at ’ e e e e O
once for all projectors in a group. : " jr— 3

\‘ _£ ;\use —

© o

The details that can be checked and operations that can be carried out at
Select "Timer" - "Timer Settings" from the Tool menu. this time are given below.

The following window will be displayed and you can then check the timer
setting status.

@ Projectors
Selects a group or projector to check the status of.
When a group is selected, the timer setting statuses for all projectors in that group
are displayed.
@ Date
Shows the current day in a red box.
Days for which timer settings have been made are shown in bold.

Click 4| or » | toswitch to the calendar for the previous or next month.
@ Timers

Shows a list of the timer settings.
The line colors in the Timers list have the following meanings:

[ ] Currentday'stimersetting
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When some of the projectors in the group have timer setting
enabled and others have it disabled for the current day's timer
setting

When the current day's timer setting is a disabled setting

11 1

Timer setting for a day other than the current day

@ Delete

Delet Lets you delete timer settings that have been selected from the
timer list.

@ Close
Close Closes the Timer Settings window.

@ Edit

Edi Lets you change the timer settings that have been selected from the
timer list. If a group has been selected for status checking, the
settings cannot be changed.

@ Add

Add Registers new timer settings. @ "Procedures for new timer
settings" p.35

© Enabled/Disabled

nsbled | Switches the timer settings that have been selected from the timer
list between Enabled and Disabled.

Dizabled

Procedures for new timer settings

Procedure

Click "Add" on the Timer Settings window. The following

window is displayed and the new timer settings are applied.

Schedule mode

Date |2009m4x14 j

Time [24 haur) |19:u4 =

Dperation |Power ON j
0K Cancel

At Operation, you can carry out the operations of turning the power
on and off and switching the input sources, similarly for the control
buttons on the main window. If you set the input source switching,
the projector's power will turn on at the timer start time even if it is
not on at the time. Because of this, it is not necessary to make two
separate timer settings for turning the power on and switching the
input source.

) After completing the timer settings, click "OK".

The timer settings that have been made will be registered and they
can be checked in the displayed timer list.

-~

-
e

Al
=

You can enable and disable all of the timer settings that have been
@‘ registered. Select Timer - Enable or Disable from the Tool menu.




Mail notification function settings

The mail notification function can be used to send corresponding
notification messages to a preset e-mail address when a projector that is il rotfcation funciion & i o
connected to the network assumes a certain status, or if it experiences a
proble.m or warning, By using this function, the operator can })e not.lﬁed of TP o P s | i _—_
a projector’s status or problems even when the operator is in a different
location from the projectors. e mal s !
Recipient mail address 1 | Maotification ewvent
~¥<- @ Up to three addressees (destinations) can be registered and messages Feckien nal sddese | lallauness
/@\ can be sent to all of them at once. Recipient mail address 3 | notification event
e If a critical problem develops with a projector which causes it to 0K Cancel
suddenly stop working, it may not be possible for the projector to
send a message notifying an operator of the problem. Make th ) hile referri he table bel
e If Standby Mode is set to Communication On (or Network On) or ake the necessary settings while referring to the table below.
Network Monitoring is set to On in the projector configuration Mail notification Set to On to use the mail notification function.
menus, you can monitor the projector even when it is in standby function
mode (when its power is turned off). @ Projector's User's Guide
(w : POwW . : ﬂ_ ] ) SMTP server IP ad- | Enter the IP address of the SMTP server. Up to a
e On some Pro;ectors, the mail n.otlﬁc.atlon function can be set in the dress maximum of 255 bytes can be entered.
Fonﬁgurat@n e When potlﬁcatlon messages are set 'Fo be sent When you change a port number of the SMTP server,
in the projector's configuration menu, both the settings in the . . c iy
. . . specify this port number. The default value is "25".
configuration menu and settings made on EasyMP Monitor are i
functional You can enter a valid number from 1 to 65535.
o Detectable status with the mail notification function differs with the Sender mail address | Enter the sender's e-mail address. Up to a maximum
projector you are using. of 255 bytes can be entered.
Recipient mail ad- Specify the destination addresses for the notification
dress 1 e-mail. Up to three destinations can be set. Up to a
Procedure Recipient mail ad- maximum of 255 bytes can be entered.
/ dress 2
Select "Mail notification function" from the Tool menu. - .
Recipient mail ad-
dress 3

The Set mail notification function window will be displayed.

Click "Notification event" and check the items for mail
notification in the window that appears.




Mail notification function settings

Set notification event

»

Lamp o

<l

Feplace Lamp

<l

Lamp failure at power on

m

<l

Lamp Cover Open

<l

Lamp Error

Prajector Direction " aming

< <

Incarrect Installation Pagition/Direction \Warming

¥ Lamp Mismatch Waming

Laser
¥ Laser Warring

¥ Laser Enor

Air Filker

<l

Clean &ir Filker Motice

<l

Mo dir Filker

<l

Lo Air Flowe

<l

Feplace air Filker

<l

Air Flow Senzor Er.

Cancel

Click "OK".
The Set mail notification function window appears again.
Repeat steps 3 and 4 to set the notification events to be notified.

o
3

m—

% / When the setup is complete, click "OK".



If the projector experiences a problem or enters a status requiring attention,
an e-mail like that shown below is sent to the address specified for

Recipient mail address.

If there is more than one problem, warning, or status, the corresponding
messages are output to separate lines.

Item

Details shown

E-mail subject

[Display name displayed in Grouping view or Detail list
view] Projector status notification

Body

<Display name displayed in Grouping view or Detail list
view> has entered the following status.

<Warning/error/status message (Please see the table
below)>

The details contained in the e-mail message can consist of the following.

Message

Remedy

Easy Interactive Func-
tion Error

Internal Error

Fan error

Sensor error

Supply System Error
(Ballast)*

Auto Iris Error

Cinema filter error

Shutter error

Cooling system error
(Peltier element)

Cooling system error
(pump)

Exhaust vent shutter
Error

Stop using the projector, disconnect the power cable
from the electrical outlet, and contact your local dealer
or the nearest address provided in the Support and

Service Guide supplied with the projector.

An e-mail notifying the operator of a problem/warning/status is issued

Message

Remedy

Phase Difference Plate
Error

Power Voltage Error

Lens Shift Error

Laser Error

Laser Warning

Lamp Cover Open

Lamp failure at power

*

on

Lamp Error*

High internal tempera-
ture error

Low air flow error

Air filter air flow sen-
sor error

Obstacle Detection Er-
ror

High-temperature
warning

Replace Lamp”

Lamp failure at power

*

on

Supply System Error
(Ballast)*

Replace Air Filter

No Air Filter

Low Air Flow

Air Flow Sensor Err.

Cinema filter warning

Refer to Reading the indicators.
@ Projector's User's Guide




An e-mail notifying the operator of a problem/warning/status is issued

Message Remedy Message Remedy

Shutter warning No Lens Error Check that the lens is installed correctly on the
projector. @ Projector's User's Guide

Obstacle Detection

warning *  When the projector has 2 lamps, the additional information, such as (Lamp 1)
Clean Air Filter Notice or (Ballast 1), is displayed after the message so that you can know which lamp
has problems/warnings.

Projector Direction

Warning Messages to inform that the projector has recovered from the error or
Lamp Mismatch Warn- warning statuses are sent.
ing

Incorrect Installation
Position/Direction
Warning

Other warning

Other error

No signal No image signals are being received by the projector.
Check the connection status and check that the power
for the connected equipment is turned on.

Network error (TCP Check the following items.

connection error) Check that the projector's power is turned on.
Check that the LAN cable is connected.

Check that Standby Mode is set to Communication On
(or Network On) or Network Monitoring is set to On
in the projector's configuration menu.

@ Projector's User's Guide

Network error Check that the projector has been correctly connected
(ESC/VP.net communi- | to the network. @ Projector's User's Guide
cation error)

Network error (Moni- | Check the projector's Monitor Password.
tor Password authenti-
cation error)




Application lock function

You can use the application lock to prevent third parties from operating the / The password entry window will be displayed, so enter the set

projectors using EasyMP Monitor and from changing settings without password and then click "OK".
authority. Opening and closing EasyMP Monitor and status monitoring can

If no password has been set (default setting), click OK without
still be carried out even when the application lock is applied.

entering a password. It is recommended that you enter a password in

In addition, when a password has been set, the password must be entered order to strengthen security.
in order to cancel the application lock. This ensures that the application The application lock will be cancelled and operations can be carried
lock can not be easily cancelled, and thus improves system security. out as normal.

Switching Application lock between Enabled and  Setting a password for cancelling application lock
Disabled

Carry out the following operations while application lock is cancelled.

Enabling the application lock

Select "Application lock" from the Tool menu.

/ Select "Environment setup” from the Tool menu.

The Environment setup window will be displayed.

The application lock will be enabled and no operations will be possible
other than opening and closing EasyMP Monitor and disabling the
application lock.

| Select "Change the application lock password".

| Enter the password in both the "New password" and "New
password (confirm)" boxes and then click "OK".

Disabling the application lock The password can be up to 16 bytes in length. Single-byte

alphanumeric characters can be used.
Procedure

Select "Application unlock” from the Tool menu.
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Appendix



Troubleshooting

Projectors cannot be monitored or controlled

Cause

Remedy

Cause

Remedy

Is the projector connected to
the network correctly?

Check that the network cable has been connected
correctly. If the cable is not connected correctly,
reconnect it.

Has the projector been set up
correctly for connection to the
network?

Check the settings for the Network configuration
menu command.

@ Projector's User's Guide

Has the projector been set up
correctly for connection to the
network?

Check the settings for the Network configuration
menu command.

@ Projector's User's Guide

Have the SMTP server IP
address, Port Number and
Recipient mail address all been
set correctly?

Check the setting details.

Has EasyMP Monitor been
installed on the computer
correctly?

Uninstall EasyMP Monitor and then re-install it.
@ p3

Are all the projectors that you
want to control or monitor
registered?

Register the projectors. @ p.11

Is the projector's Standby
Mode set to Communication
On (or Network On) or
Network Monitoring set to On
in the configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby mode, the
projector's Standby Mode must be set to
Communication On (or Network On) or Network
Monitoring must be set to On in the configuration
menu.

@ Projector's User's Guide

Is the projector's Standby
Mode set to Communication
On (or Network On) or
Network Monitoring set to On
in the configuration menu?

In order to use EasyMP Monitor to monitor and
control the projector when it is in standby mode, the
projector's Standby Mode must be set to
Communication On (or Network On) or Network
Monitoring must be set to On in the configuration
menu.

@ Projector's User's Guide

Has a critical problem
developed causing the
projector to momentarily stop
working?

When the projector has momentarily stopped
working, it cannot send e-mail messages. If the
projector cannot be reset even after it has been
checked, contact your dealer or the nearest address
provided in the Support and Service Guide supplied
with the projector.

An e-mail message is not sent when a problem
occurs with a projector

Is power being supplied to the
projector?

Check if the power supply to the location where the
projector is set up has been interrupted, or if the
circuit breaker for the electrical outlet that the
projector is connected to has been tripped.

Cause

Remedy

Is the projector connected to
the network correctly?

Check that the network cable has been connected
correctly. If the cable is not connected correctly,
reconnect it.




Uninstalling EasyMP Monitor

To save or transfer the existing projector settings, make a copy of the EMP
Monitor.dat file before you uninstall the software. @ "Transferring the
settings" p.7

The following procedures to uninstall EasyMP Monitor vary depending on
your operating system.

e If your operating system is Windows 2000 or Windows XP
Click "Start" - ("Settings") - "Control Panel" - "Add/Remove Programs" or
"Add or Remove Programs" to uninstall EasyMP Monitor.

e If your operating system is Windows Vista, Windows 7, or Windows
10
Click "Start" - "Control Panel" - "Uninstall a program" to uninstall
EasyMP Monitor.

Az

~- If your operating system is Windows 10, right-click "Start", and then
@‘ click "Control Panel".

4

o If your operating system is Windows 8 or Windows 8.1
Select "Charms" - "Search”, and then right-click (press and hold) "EasyMP
Monitor Ver.X.XX". Select "Uninstall" from the app bar to uninstall
EasyMP Monitor.

~»~<-  Under Windows Vista, Windows 7, Windows 8, Windows 8.1, and
@ Windows 10, settings and logs remain on the hard disk even after
EasyMP Monitor is uninstalled. If you do not need this information,
delete the EasyMP Monitor Ver.X.XX (Ver.X.XX represents the version
of the existing software) folder. This folder can be found at "C:\Users
\(User Name)\AppData\Local\VirtualStore\Program Files\EPSON
Projector” if the default settings were used to install the software.




General Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval ©SEIKO EPSON CORPORATION 2016. All rights reserved.
system, or transmitted in any form or by any means, electronic, mechanical,

photocopying, recording, or otherwise, without the prior written permission of Seiko

Epson Corporation. No patent liability is assumed with respect to the use of the

information contained herein. Neither is any liability assumed for damages resulting

from the use of the information contained herein.

413295400EN

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this
product or third parties for damages, losses, costs, or expenses incurred by the
purchaser or third parties as a result of: accident, misuse, or abuse of this product or
unauthorized modifications, repairs, or alterations to this product, or (excluding the
U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or problems arising
from the use of any options or any consumable products other than those designated as
Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

The contents of this guide may be changed or updated without further notice.

Ilustrations in this guide and the actual projector may differ.

Trademarks

Microsoft, Windows, Windows Vista, and the Windows logo are trademarks
of Microsoft Corporation in the United States of America and other
countries.

Macintosh is a registered trademark of Apple Computer, Inc.

Pentium is a registered trademark of Intel Corporation.

EasyMP and EasyMP.net are trademarks of Seiko Epson Corporation.
Other product names used herein are also for identification purposes only
and may be trademarks of their respective owners. Epson disclaims any and
all rights in those marks.
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